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Please note: This software program is distributed with the understanding that neither the
Developers nor the Publisher is engaged in rendering legal or accounting services.
Questions relevant to the practice of law or accounting should be addressed to a member
of those professions. The Developers and the Publisher specifically disclaim any liability,
loss, or risk, personal or otherwise, which is incurred as a consequence, directly or
indirectly, of the use and application of any of the contents of this work.

Overview

MFTC32: Mutual Fund Tax Calculator, 32-bit edition, provides a facility for determining
the tax cost of redeemed shares (full or partial) in one or more mutual fund accounts. The
program computes dividends, capital gains distributions, redemptions, and purchases on
an average-cost basis. It is meant to provide a simple, non-technical method for those
mutual fund accountholders who must file Schedule D (Capital Gains & Losses) on IRS
Form 1040 to cover their fund redemptions during any tax years.

When a holder of shares in a mutual fund redeems any portion of shares in the account,
the IRS requires that holder to file Schedule D and list not only the date of redemption
and the redemption amount, but also the date of acquisition and the exact cost of those
shares (full and fractional) redeemed. MFTC32 is meant to assist the shareholder in
making the determination of cost along with a record of the needed dates. Since shares
are often purchased and distributions reinvested at different times at varying Net Asset
Value (NAV) figures, a system of determining average share cost basis (along with other
recordkeeping) may be advantageous for the account. MFTC32 may be used with any
number of fund accounts and works with both equity and bond funds that are purchased
in full and fractional shares. Once the cost of the redemption(s) during the tax year(s) has
been determined, it is relatively easy to ascertain the gain or loss incurred for each
redemption and make the appropriate entries as required on the Schedule D tax form.

The situation shareholders find when attempting to determine a tax-basis cost is
complicated by the income dividend and capital gain distributions made by the fund
management during any given year; bond funds that pay a monthly or quarterly dividend
are in particular need of constant updating and accurate recordkeeping. Equity funds
often make Short Term Capital Gains Distributions (STCG), Long Term Capital Gains
Distributions (LTCG), as well as Dividend (Div) or Income (Inc) Distributions.

Most fund managers assist with regular reports to help determine some portions of tax
cost; a number attempt to assist with determination of cost of redemptions, although
some may argue that the so-called "average-cost" basis is not suitable for all
shareholders and must be determined on an individual basis by the shareholder and a



qualified accountant. When presented with the different options, most mutual fund
accountholders will elect to use the simple, accurate method of "average-cost"
determination of cost along with the First-In, First-Out (FIFO) method for determining
which shares have been redeemed for any redemption transaction. MFTC32 uses an
average-cost method; you may also wish to employ FIFO determination. Both models
are conceptually acceptable by the IRS, and are often suggested in tax manuals as
methods to determine tax cost and acquisition dates of redeemed shares.

The net gain or loss on fund shares sold is the difference between proceeds from the
shares redeemed and the tax cost of those shares. When determining the holding
period, the shareholder may refer to the "trade date" on fund company confirmation
statements, which reflects the date shares were actually bought or sold. If the shares
redeemed were not acquired at the same time (which is almost always the case with
mutual fund investments), it should be acceptable to enter the word "various" for the Date
Acquired entry on the Schedule D form. (Shareholders should consult a qualified tax
counselor or the appropriate IRS documentation for additional information pertaining to
an individual's tax situation as regards mutual fund shares.)

In MFTC32, fund tables may be made up of long filenames and may be viewed/edited in
either Form or Table view. An easy-to-use single-button selection for the Report Writer
prints formatted tabular reports for each fund table. Complete documentation and help is
available online, as well as in Windows .DOC format (suitable for printing).

The unregistered copy is fully-functional as to the features and components found in the
full registered copy; it allows creation of as many fund tables as the user wishes in order
to satisfactorily and fully evaluate the program. The tables have a limitation on the
number of transactions that may be viewed/edited in any particular table; that limit is
fifteen transactions per table. Any tables created with the unregistered copy will be fully
and immediately usable with the registered version.

Main Switchboard

The program begins with a display window, the Main Switchboard, from which all
selections can be made, either via command buttons, menu selections, or, in some
instances, by choosing a button on the Toolbar.

From the Main Switchboard, you may make a selection of the Fund Table you wish to
work with (or create a new Fund Table, if needed) and then choose either Table or Form
View options for data entry, viewing and editing.

The File Menu on the Main Switchboard will maintain an MRU (most recently used) fund
table list providing a facility for opening any of up to six of the last fund tables used; after
making a selection, choose the appropriate view (Form or Table) desired.

You may exit the program by pressing the <Exit> button on the Main Switchboard screen.

Main Toolbar

The Main Toolbar, appearing in the upper left portion of the Main Switchboard, Form
View, and Table View windows, consists of three toolbar buttons:



<Calculator> Launches the Windows Calculator applet.

<Calendar>Displays the MFTC32 Calendar.

<On-Line Documentation> Brings up the Contents page of the MFTC32 Help window.

Placing the mouse pointer momentarily over a Toolbar button will cause a help reminder
flag to appear as to the button's function. The functions of these toolbar buttons also
appear as menu items for the relevant windows.

Command Buttons on the Main Switchboard

The Command Buttons appearing on the Main Switchboard screen are:

<Table View> Opens the fund table in Table View, an alternate viewing and data entry
screen. Allows viewing of multiple records at one time. Columns may be resized and
moved for the session. Contains a Detail View window option providing a view similar to
that of Form View. Reports may be created from this view.

<Form View> Opens the fund table in Form View, the primary entry screen for
MFTC32. Provides viewing of a single data record with all data cells on the screen at
one time; cells that may not be edited are in grey text. Reports may be created from this
view.

<Create New Fund
Table> Create a fund table for each mutual fund for which records are to be maintained.

<Exit> Exits the program.

These functions also appear as menu items for the Main Switchboard window.

Creating Fund Tables

To create fund tables for each equity or bond fund that you own, select the <Create New
Fund Table> command button on the Main Switchboard (or select the Create Table item
on the File menu). Enter a title designation that briefly fits the fund name; you may use a
long filename of up to fifty (50) characters beginning with a letter or number; do not
specify an extension. MFTC32 will create a new fund table and append the .FND
extension to the name you have indicated. (Repeat this process for each fund for which
you wish to maintain records in MFTC32.) Fund tables are stored in the folder in which
MFTC32 is installed; they may be moved as needed.

You may now use the Fund Selector on the Main Switchboard to select the new fund and
begin working with it in Table or Form View. You should enter transactions from your
fund statements from the beginning date of your initial investment to the present, so that
the average share cost calculation will be accurately reflected and easily maintained for
future transactions.



Form and Table Views

Table View presents your data in a spreadsheet-like grid showing multiple records in
rows within a single screen. You may scroll right to view other columns.

Form View displays the same material, one record per screen with all available cells in
view at the same time.

Data entry may be accomplished in either Form or Table View. Initially, you may find that
Form View offers the quickest method for new data entry. The cells that are available for
your entry/edit are highlighted with color text in the cells. Cells that are calculated by
MFTC32 are in grey. In Table View, editable columns are distinguished by color, and a
Detail window (similar to Form View) is provided that greatly facilitates data entry.

You may begin by selecting a fund table (with the Fund Selector on the Main
Switchboard) to work with; if you are a new user, select the SAMPLE.FND and view the
layout, make practice entries/changes, etc. (SAMPLE.FND may be deleted from the
folder with Explorer after your own tables have been created and the program is familiar
to you.)

For each record (or row in Table View) you will enter only one transaction: a purchase, a
redemption, an income or dividend payment, an STCG or LTCG distribution, a fee
deduction, etc. Maintain your tables in date order as indicated on the statements you
receive from the fund company; the tables are not sorted in any manner by the program,
so it is up to you to maintain proper date order. The Record No. indicator provides the
current record's sequence number.

Please note the special "Self" cell which indicates a transaction initiated by yourself (a
purchase or redemption), as opposed to one made by the fund company (income
dividend, etc). Simply enter a check-mark in Form View with the mouse or <Spacebar>
for those transactions which are attributable to "self;" in Table View, the Self cell is
indicated by the logical entry "Y" or "N." If the Self entry is incorrect, then the calculation
of the fund table by MFTC32 may be incorrect.

After you have entered the required data items into the table, you may press the
<Recalculate> key to allow MFTC32 to update the calculated cells (i.e., those which are
disallowed from data entry and appear in grey in Form View).

The calculated cells include (in Form View):

Net Investment (to Date) A summary of your net purchases less your net redemptions
(i.e., "Self" transactions), to date. Does not include fund company-initiated items: income
or other distributions (reflected in Cumulative Tax Cost).

Purchase Shares this
Transaction Full & fractional shares acquired, to 3 decimal places; should agree with

that indicated by your fund statement.

Sale Shares this Transaction As above, indicating the result from a redemption
transaction.

Cost of Shares Sold Currency amount reflecting the cost of redeemed shares this
transaction, based on prior Avg Cost per Share calculations. This figure should be
helpful in preparing your Schedule D tax form.



Share Balance Indicates the number of full & fractional shares (to 3decimal places) in
your account as of the current transaction; should reflect same indicated on your fund's
statement.

Market Value Market Value in currency as of the currenttransaction at the currently
indicated NAV for this record.

Cumulative Tax Cost A summary in currency amounts of all purchases and
distributions less redemptions. Differs from Net Investment cell as it includes non-self
transactions.

Avg. Cost per Share
(Tax Basis)A currency figure shown to 4 decimal places. This is the crucial figure used

in determining your tax cost of shares redeemed for Schedule D tax purposes. Based on
an average of all purchases & distributions, to date. Used by MFTC32 to determine the
Cost of Shares Sold cell calculation.

These same cells appear in Table View as well, although they may have slightly different
column designations (due to space limitation). Their function in Table View is exactly the
same. In Table View, these cells are indicated by the darker teal-colored columns.

If you feel that the Net Investment cell is inaccurately reflected after a recalculation, you
should ascertain that the logical Self cell has been properly marked for all transactions in
the table.

For each redemption, a drawing down by the same amount will occur in the Net
Investment cell (but never less than zero). If you perceive that your redemption is wholly
or partly from non-self purchases (i.e., fund income or other distributions), then the
amount reflected in the Net Investment cell shall not be applicable to your situation. The
Net Investment cell has no effect on the true average cost calculations.

If the <OK> button is pressed without properly posting changes or additions, the newly
entered material will not be written to the table. Recalculating will post any changes, as
does selecting the <Post> button on the Navigational Toolbar.

Navigational Toolbar

The long Navigational Toolbar in both Table and Form Views contains buttons
representing the following actions, from left to right:

<First> Sets the current record to the first record in the table.

<Prior> Sets the current record to the previous record.

<Next> Sets the current record to the next record.

<Last> Sets the current record to the last record in the table.

<Insert> Inserts a new record before the current record.

<Delete> Deletes the current record in Form View; in Table View, deletes the record
at which the record pointer in the leftmost column appears. Prompts for confirmation



before deleting.

<Post> Writes changes in the current record to the table.

<Cancel> Cancels edits to the current record.

Placing the mouse pointer momentarily over a Toolbar button will cause a help reminder
flag to appear as to the button's function.

Command Buttons

The Command Buttons that appear in both Table and Form Views consist of:

<Append Record>Adds a new, blank record to the end of the data table.

<Recalculate> Performs a math recalculation on the entire table for updating
purposes. (Multiple records may be entered/edited before recalculating.)

<Window Print> Sends the contents of the window to the printer.

<Table Print> Prints the contents of the current table in tabular report format.

<OK> Closes the window.

Form View contains an additional button:

<Today> Enters the current date into the Transaction Date cell.

Table View contains one additional tool-style button:

<Detail> Opens the current record in a Detail View for enhanced data entry or
viewing.

Placing the mouse pointer momentarily over a Command Button will cause a help
reminder flag to appear as to the button's function.

Editing in Form View

The following cells are available for data entry within Form View: Transaction Date,
Transaction, Self, Purchase Amount, Redemption Amount, and NAV (Net Asset Value).
You may press the <Tab> key to move from cell to cell (or <Shift-Tab> to move in the
previous direction) on the same form view.

You may add a new, blank record to the end of the table by pressing the <Append
Record> command button. You may utilize the navigational buttons on the Navigational



Toolbar to move to variously positioned records in the table (see the section,
"Navigational Toolbar").

When editing a new record, you may press the <Today> button to enter the current date
into the Transaction Date cell, if desired. Otherwise, you may click the mouse pointer on
the Transaction Date cell and begin typing a date; you need not enter the forward slash
symbol ( / ) as the program will enter that for you. For the months January through
September, enter a zero (0) as the initial character for the month; i.e., to enter an April
date, begin with "04" as in, 040597 (April 5, 1997).

The Transaction cell will contain your reference to the Transaction, such as Purchase (or
Purch or PURCH), Exchange From, Exchange To, Check-Writing Redemption, Income
(Inc or INC), Dividend (Div or DIV), STCG, LTCG, Fee, etc. Although the entry here may
be up to fifty (50) characters of your choice, you may prefer to keep the entry as brief as
possible with abbreviations or short indications, to speed up data entry.

The Self cell is a logical type entry, indicating Yes (Checked) or No (Unchecked) that the
transaction is one which you yourself have made (Purchase or Redemption), as opposed
to one created by the mutual fund company (Income, Dividend, Capital Gain Distribution,
Fees, etc.). Either click the mouse in the Self cell or press <Spacebar> to alternate
between indicating a Check or Unchecked indication. (In Table View, this cell is marked
with "Y" (Yes) and "N" (No) letters to indicate the same functions, a logical Checked and
Unchecked, respectively.) Do not leave this cell incorrectly indicated.

In the Purchase Amount cell, enter the appropriate amount if the transaction was a
Purchase by yourself or a Distribution from the fund company. Do not attempt to enter a
Purchase transaction into the same record that contains a Redemption transaction. Enter
only one transaction per record.

If the transaction is a Redemption rather than a Purchase, enter the appropriate figure
into the Redemption Amount cell. Do not attempt to enter a Redemption transaction into
the same record that contains a Purchase transaction.

In the NAV cell, enter the currency figure that indicates the Net Asset Value amount at
which the shares were either purchased or redeemed. Obtain the NAV from your fund
statement (i.e., the currency amount share price at which shares were purchased or
redeemed as of the transaction date). Even though the NAV cell is always rounded to
two decimal places on screen, you may enter additional decimal places if needed in
special circumstances; calculations will be based on the number you enter even though it
will show a rounded representation on screen.

After the NAV entry, the table may then be recalculated to update the various other cells
for you. Those other cells are ones which are not available to you for edit or entry in
Form View; their updating is performed by MFTC32. The non-edit cells are: Net
Investment to Date, Purchase Shares this Transaction, Sales Shares this Transaction,
Cost of Shares Sold, Share Balance, Market Value, Cumulative Tax Cost, and Average
Cost Per Share (Tax Basis). These cells are greyed in Form View, with white-colored cell
indicators that distinguish them from the active cells that are in labeled with teal-colored
cell indicators.

You may create a hard-copy reference of any needed Form View screen simply by
pressing the <Window Print> button. The image will be sent to your printer if it is online.
(Technical note: Certain printers, notably the HP LJ II, may have difficulty with the
Window Print function; Window Print will not be usable in such instances.)

A complete, formatted tabular report for the current table may be created by selecting the
<Table Print> button on the Form View screen. A print dialog window prompts for
confirmation, at which time the MFTC32 Report Writer sends the report (in landscape



mode) to the currently selected printer.

Editing in Table View

Enter only one transaction per record (row).

When using the Table View screen, edits and insertions within a cell are posted only
when you move to a different record (row) on the Table View grid. Even if you use the
mouse to change focus to a command or toolbar button on the screen, the changes are
not posted until you move off the current row.

You may cancel all edits for a record by pressing the <Esc> key in any field before
moving to another record.

You may immediately post an edit by pressing the <Post> button on the Navigational
Toolbar or by selecting the <Recalculate> command button to recalculate the entire
table.

You may begin typing in the cell on which the highlight is placed to begin edit mode. You
may press the <Tab> key to move from cell to cell (or <Shift-Tab> to move in the
previous direction) in the same row. When you are finished with the edits, click on the
<Post> button in the Navigational Toolbar to write the information to the table. Pressing
the <Recalculate> button will also post the edits; doing so will recalculate the entire table,
which will take extra time on a large table or with a slower computer. You may enter
many records or edits and save the recalculation as the last action in order to speed up
data entry.

Please note that the Self cell is a logical type entry, indicating "Y" (Yes) or "N" (No) that
the transaction is one which you yourself have made (Purchase or Redemption), as
opposed to one created by the mutual fund company (Income, Dividend, Capital Gain
Distribution, Fees, etc.). Type either Y or N in the Self cell, as appropriate. (In Form and
Detail Views, this cell is marked with a logical Checked or Unchecked, respectively, to
indicate the same functions.) Do not leave this cell blank.

In the Purchase Amount cell, enter the appropriate amount if the transaction was a
Purchase by yourself or a Distribution from the fund company. Do not attempt to enter a
Purchase transaction into the same record that contains a Redemption transaction. Enter
only one transaction per record.

If the transaction is a Redemption rather than a Purchase, enter the appropriate figure
into the Redemption Amount cell. Do not attempt to enter a Redemption transaction into
the same record that contains a Purchase transaction.

You need not attempt to edit the following cells in Table View: Net Investment, Purch
Shs this Trans, Sale Shs this Trans, Cost of Shares Sold, Share Balance, Market Value,
Cumulative Tax Cost, and Avg Cost Per Share. Any such edits will be changed with the
updating brought about by pressing the <Recalculate> button. The non-edit cells
mentioned above correspond to the cells which are greyed out and not available for edit
in Form View. In Table View, these cells are indicated by the darker teal-colored
columns.

An Edit Cell/Non-edit Cell LED indicator is provided in the lower panel of the Table View
screen that serves as a helpful reminder as to which cells are editable. As you move



from column to column, the indicator will reflect the intended Edit (green LED) or Non-
edit (red LED) nature of a cell. Simply tab past a non-edit cell during your data entry and
allow table recalculation to automatically fill in such cells. The darker teal-color columns
of cells correspond to the red LED indicator, while the editable light-color columns are
confirmed with the green LED indicator.

The left edge of the Table View grid contains a triangular-shaped pointer which indicates
the current record having the active focus. You may position this Record Selector on any
existing or newly appended record by clicking on (or moving to) the record, and perform
edits on that record.

If you click on the <Detail> button just to the right of the Navigational Toolbar, you will
open the current record (as indicated by the Record Selector) in a Detail View very much
like that of the Form View screen. In Detail View you may perform edits the same as you
do in Form View, including editing a blank record newly appended in Table View, or
simply view all fields for the record at one time. You may not, however, insert or delete
records, nor can you recalculate the fund table from Detail View.

After performing any needed edits in Detail View, you must <Post> the edits with the
appropriate button selection on that window's special Navigational Toolbar. You may
move forward and back within the table with the applicable Toolbar buttons, noting that
the record selector on the Table View screen in the background moves appropriately as
well. Click on the <OK> button to return to full Table View and <Recalculate> the table
as needed.

You may add a new, blank record to the end of the table by pressing the <Append
Record> command button while the highlight is anywhere on the Table View grid, or by
pressing <DownArrow> while editing the current last (bottom) record. You may then
press <Ctrl-LeftArrow> to return the highlight to the leftmost cell of the new record.

You may create a hard-copy reference of the currently displayed Table View or Detail
View screen simply by pressing the <Window Print> button. The image will be sent to
your printer if it is online. (Technical note: Certain printers, notably the HP LJ II, may
have difficulty with the Window Print function; Window Print will not be usable in such
instances.)

A complete, formatted tabular report for the current table may be created by selecting the
<Table Print> button on the Table View screen. A print dialog window prompts for
confirmation, at which time the MFTC32 Report Writer sends the report (in landscape
mode) to the currently selected printer.

Rearranging Column Order and Resizing Columns in Table View

In Table View, you can use the mouse to drag a column to a new location for the current
session. For example, you may wish to move the Average Cost column from the far right
position next to the Transaction Date column so that you may more easily peruse the
sequence of changes in average share cost over a period of time.

To move a column: Click the mouse pointer on the heading (column title) for the column
you wish to move; holding down the mouse button, drag the column to the desired
position. Multiple dragging operations may be needed to effect a long move.

You may also Resize columns for a session. For example, if you resize the large
Transaction column to a more narrow width, you will be able to have more columns in



view on the screen during the current session.

To Resize a column: As you move the mouse pointer to the column heading (column
title) you will note the mouse cursor changes shape; click on the edge of the column
separator and hold down the mouse button while dragging the separator to the position
desired. Release the mouse button and the column will remain in that position for the
session or until it is resized again.

Please note that column Rearrangement and Resizing will appear as you have placed
them on a printed copy of the window, if you should use the <Window Print> button.

Column Rearrangement and Resizing last throughout the current session with MFTC32
and return to to their default behavior with the next launch of the program.

Editing in General

Traditional Windows cut and paste operations may be utilized as necessary. In order to
use the Windows Clipboard cut and paste facilities, you need only understand the simple
process of text selection with the mouse. Selection may consist of an entire cell or only
parts.

The <Ctrl-C> key combination will Copy selected text to the Windows Clipboard. <Ctrl-
V> will Paste the contents of the Windows Clipboard to the location at which the insertion
point is placed. To overwrite existing text with incoming text, select the existing contents
(or portions thereof) first before issuing the Paste command. Text from a cell may be
copied to other applications (such as Notepad or WordPad) in like manner.

Records may be inserted or deleted anywhere within a table by using the <Insert> or
<Delete> keys on the Navigational Toolbar. Remember to recalculate the table before
utilizing (or printing) contents of calculated cells after an insertion or deletion. You may
add, edit, or delete multiple records in any number before recalculating; doing so will
speed data entry in that the recalculation need only be performed after the final
modification.

In both Form and Table Views, you may call up two handy applets, Windows Calculator
and MFTC32 Calendar, simply by pressing the appropriate buttons on the Main Toolbar.
For the Calculator applet to be available in MFTC32, you must not have deleted Calc.
exe from your Windows directory. For help in using that program, consult your Windows
documentation or the online help for Calculator.

The Report Writer (Table Print button in Form & Table View)

A complete, formatted tabular report for a selected table may be printed by selecting the
<Table Print> button on the Form View or Table View screen. A print dialog window
prompts for confirmation; the report is then printed in landscape mode and outputs the
entire table. Due to space limitations, the Transaction column is limited to printing the
first eleven (11) characters in that column; the Self column is omitted from the printed
report. The column headers (titles) are abbreviated where needed. All records posted to
the current table are included in the report.



The multiple-page report is designed for printing on 8 1/2 x 11 inch letter-size paper in
landscape mode (horizontal position) only. It includes the date of the report on the first
page, as well as the name of the fund table on the first and all succeeding pages.

A progress gauge on the Report Status window shows an approximation of the
completion of report preparation.

The About screen

Selecting the About item on the File Menu brings up information on product name,
version number, and copyright information. To close the About screen, click on the
<OK> button.

Online Documentation and Help

The online documentation may be read after MFTC32 by selecting the <Documentation>
button on any page, or by pressing <F1>. Pressing the <Documentation> button brings
up the Contents page of the MFTC32 Help; from the Contents page, you may click on an
item to go directly to a topic, or click the >> (Next) button on the Windows help screen to
browse through the topics in documentation sequence. Pressing <F1> while the focus is
on other components provides context-sensitive help.

To print portions of the Documentation, select the desired section of the text with the
mouse. Press the <Ctrl-C> key combination to copy the selection to the Windows
Clipboard. You may then Paste (Ctrl-V) the contents of the Clipboard into a text editor,
such as Windows Notepad, and print the contents from that application's File Menu or
other print facility. You may also use the Print Topic item on the Help screen's Options
menu to print the current topic.

You may open the included MFTC32.DOC file (this file) in Windows WordPad (or any
Windows word processor that can read the .DOC format, such as Microsoft Word) and
print the documentation from that program.

Program specifications

MFTC32 requires an 80386sx or greater processor and 32-bit Windows operating
system.

Installation

To install MFTC32: Mutual Fund Tax Calculator, run Setup.exe.

The online documentation may be read after launching MFTC32 by selecting the
<Documentation> button on any page, or by pressing <F1>. Pressing the
<Documentation> button brings up the Contents page of the MFTC32 Help; from the



Contents page, you may click on an item to go directly to a topic, or click the >> (Next)
button on the Windows help screen to browse through the topics in documentation
sequence. Pressing <F1> while the focus is on other components provides context-
sensitive help.

You may also print (highly recommended) or view a formatted version of the
documentation by opening MFTC32.DOC (this file) in Windows WordPad (or any
Windows word processor that can read the .DOC file format, such as Microsoft Word)
and utilizing the print facility from within that program.

To uninstall this program, open Control Panel, select Add/Remove Programs. Under
Install/Uninstall select MFTC32, click on Add/Remove... and answer the Remove prompt
appropriately.

Notes & Precautions

Floating point error messages
During data entry, if you leave a zero currency amount (0.00) in the Purchase Amount,
Redemption Amount, and NAV cells in any record (row) and then press the
<Recalculate> button, you will receive an error message "Invalid floating point operation.
" This situation will likely occur if you <Append> a blank record, do not enter data, and
subsequently press the <Recalculate> button.

Similarly, if you have a valid currency amount (i.e., greater than 0.00) in either the
Purchase Amount or Redemption Amount cells in any record but have 0.00 entered into
the NAV cell and press the <Recalculate> button, you will receive the error message
"Floating point division by zero."

These occurrences result from "divide by zero" situations that cannot be handled by your
computer's processor.

To avoid these error messages, simply ensure that you have entered valid currency
amounts (that is, greater than 0.00) in either the Purchase Amount or Redemption
Amount cells, as well as the NAV cell, in ALL existing records before recalculating.

If you have appended an unneeded record, simply select that record (with the left-edge
grey Record Selector in Table View, or, in Form View make that the active record shown
on screen), and then press the <Delete> button on the Navigational Toolbar.

Rounding differences
At times, you may notice some small fractional difference in the result that MFTC32
calculates for the Share Balance cell and the share balance indicated on your fund's
statement. Usually, this difference is but a couple thousandths of a share and may
appear to be persistent over time. It results primarily from rounding calculation methods
on PCs that may differ from that of the fund companies and their mainframe computers.

MFTC32's calculations are done to accuracies of fifteen decimal places and rounded to
show three decimal places (four in the Avg. Cost per Share cell). It would be impractical
to attempt absolute rounding coordination with the various calculation methods of the
many fund companies. Users of PC spreadsheet applications often must deal with the
same sort of rounding differences resulting on different systems. For most practical



purposes, the differences of some thousandths of a share will have little or no effect on
the overall accuracy or usefulness of calculations made with MFTC32.

Backups
You should maintain regular backups of your fund tables (*.FND) and their related
validation (*.VAL) files in order to prevent loss to your data entry effort. It is the .FND files
that get updated when you do your calculations, so you will want to include them in any
daily backups that you may perform. You may simply use Windows Explorer to copy
these files from the folder in which MFTC32 was installed over to a formatted floppy
diskette. You may also use commercial or other backup software, including the Microsoft
Backup program that comes with Windows.

MRU List
The File Menu on the Main Switchboard will maintain a standard MRU (most recently
used) fund table list providing a facility for opening any of up to six of the last fund tables
used; after making a selection, choose the appropriate view (Form or Table) desired.

As the program is used, the MRU List will display the last six fund tables that were
opened and viewed/edited. The MRU List is recalled from session to session and offers
a quick way to choose from the last opened fund tables. To choose one of those fund
tables to work with, simply select them on the File Menu with the mouse, arrow keys, or
by pressing the appropriate number key associated with the fund table name. You need
only then to select a view (Form or Table) and begin working with that fund table.

Please note that a fund table, including a newly created one, will not appear on the MRU
List until viewed or edited in either Form or Table View.

Fund Table Names
A fund table name consists of those portions of a long filename allowable under Microsoft
32-bit Windows file naming conventions. That is, there is a first part of the name (which
you specify) that can include up to fifty (50) characters beginning with a letter or number.
There is also an extension part of the filename which consists of three characters
preceded by a period ( . ). The extension in MFTC32 for a fund table name is ".FND"
and is appended by MFTC32 automatically; you do not type in the ".FND" when creating
a fund table name. The user need only specify the first portion of the filename.

For example, if you are attempting to create a fund table for your account in the T. Rowe
Price Growth & Income Fund, you may specify an appropriate table name within the fifty-
character limit such as "T. Rowe Price Growth & Income" (no extension). After clicking
on <OK> in the Create Fund Table dialog box, MFTC32 will create a new fund table and
append the .FND extension to the name you have indicated. The resulting fund table
will be a file with the long filename of "T. Rowe Price Growth & Income.FND" (or
whatever). (By the way, the ampersand ( & ) character in the example above may not
always display properly in MRU file lists and fund name reminder displays; this is not a
flaw in MFTC32 but a characteristic inherent in the operating system. If you indeed wish
to utilize the ampersand character fully, enter a double ampersand ( && ) at the point at
which you wish the ampersand to appear.)

Licensing Information



This program is licensed and supplied as is, without any warranty. To the extent
permitted under applicable law, RCCO Research Associates disclaims all warranties,
either expressed or implied, with respect to this software program, its quality,
performance, merchantability, or fitness for any particular purpose.

In particular, this software program is not guaranteed to prevent or detect damage to your
data or programs. In no event shall RCCO Research Associates be liable for any claims
for lost profits or any damage, including, but not limited to, special, incidental,
consequential or other damage (including, without limitation, damages for loss of
business profits, business interruption, loss of business information, or other pecuniary
loss) arising out of the use of or inability to use this RCCO Research Associates product,
even if RCCO Research Associates has been advised of the possibility of such damages.
Some states do not allow the exclusion or limitation of incidental or consequential
damages, so the above limitation or exclusion may not apply to you. In no case shall
RCCO Research Associates' liability exceed the license fees paid for the right to use the
licensed version of the software.

The license agreement and warranty shall be construed, interpreted and governed by the
laws of the state of Tennessee.

Windows(R) is a registered trademark of Microsoft Corporation. Other trade names
referenced herein are either trademarks or registered trademarks of their respective
companies.

The registration fee licenses one copy for use on any one computer at any one time. Site
licenses are available from RCCO Research.

The unregistered version of this program is intended for use in evaluation situations only.
It may be used for ninety (90) days by yourself and within your own organization by
persons that have knowledge and understanding of the fact that this is an unregistered
evaluation copy.

Registration Notes

The unregistered copy is fully-functional as to the features and components found in the
full registered copy; it allows creation of as many fund tables as the user wishes in order
to satisfactorily and fully evaluate the program. The tables do have a limitation on the
number of transactions that may be viewed/edited in any particular table; that limit is
fifteen transactions per table. Any tables created with the unregistered copy will be fully
and immediately usable with the registered version.

You are granted an evaluation period of up to 90 days to determine whether or not you
wish to purchase a registered copy of this software. To purchase a registered copy, you
may mail the registration fee of U.S. $27.95 + $2.55 handling ($7.05 outside of U.S.A.,
$4.05 for Canada) directly to RCCO Research, P.O. Box 196, Gatlinburg, TN 37738 (U.
S.A.); you will receive a registered copy of the latest version on two 3.5" 1.44mb disks.
Additional users for business purposes are $17.00 each and may be licensed at the time
of registration or later as they may be added at the then current license fee in effect.
Please remit with check or money order only (no currency). For credit card and
telephone orders, see Additional Ordering Options note below.

Tennessee clients please include the required 8.5% sales tax on both the product
amount and shipping/handling as mandated by the state.



The purchase of a registered copy of MFTC32: Mutual Fund Tax Calculator (32-bit
edition) may be tax deductible. Please consult a tax advisor.

International clients must pay by check or money order in U.S. dollars, drawn on a U.S.
bank or the U.S. branch of an international bank. Please realize that international postal
money orders are considerably delayed through the postal systems and may not be the
most expedient way of relaying payment. An often-used form of payment consists of
obtaining a dollar-denominated money order from the local American Express office
which you may then airmail to us along with your order. International orders are
dispatched promptly when using a credit card order as outlined below.

Please indicate the exact program name (MFTC32) and current version number on your
order; you may use the Order.frm file provided with the program or simply send a note or
letter with your name, organization name, address, program name & version, and
remittance.

Additional Ordering Options:
------------------------------------------------------------------------------------------------
CREDIT CARD ORDERS ONLY -
You may order a registered copy of this RCCO Research program
with MasterCard, Visa, Amex, or Discover from PsL, Public (software)
Library of Houston, Texas by calling 1-800-242-4775 or 713-524-6394,
or by FAX to 713-524-6398, or by CompuServe E-mail to 71355,470.
PsL's office hours are 7:00am to 6:00pm CST Monday-Thursday and
7:00am to 12:30pm CST on Fridays. You may also mail credit card
orders to PsL at P.O. Box 35705, Houston, TX 77235-5705 (U.S.A).
Please include the cardholder name exactly as it appears on the
credit card plus the billing address for the card.

PsL's item/product number for MFTC32: Mutual Fund Tax
Calculator, 32-bit edition, is #11990-32.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.
Any questions about the status of the shipment of the order,
registration options, product details, technical support, volume
discounts, dealer pricing, site licenses, etc. must be directed in
writing to RCCO Research, P.O. Box 196, Gatlinburg, TN 37738. To
ensure that you get the fastest possible delivery of your registered
copy, PsL will notify us the day of your order and we will promptly
ship the materials directly to you. There are no additional fees
for ordering by credit card.

Your credit card number is not transmitted to RCCO Research, but
rather is processed by PsL as part of their worldwide software
registration service.

The above service is made available as a convenience to client
individuals who wish the security and expediency of ordering by
telephone and/or with a credit card. Established business concerns
may prefer to order directly from RCCO Research with the company's
own business check.

The PsL staff cannot answer non-order inquiries.
------------------------------------------------------------------------------------------------



Additional Information

If you have any comments or questions regarding this program after (or with) registration,
please direct them to:

RCCO Research Associates
P. O. Box 196
Gatlinburg, TN 37738-0196
(U.S.A.)

Special e-mail addresses for registered users' use are provided along with the invoice.

To print the registration order form from Notepad (or other text editor), open the file
Order.frm in the MFTC32 folder. From the File menu of Notepad, select Page Setup to
set all margins minimally: 0 for Left, Right, Top, Bottom Margins. Delete the default
header and footer items. Select OK. Then from the File Menu, select Print to print out
the order form. (If you wish to fill in the form with your order information before printing, it
may be best to open Order.frm in a word processor, such as WordPad, since Notepad
does not have an overwrite mode.)

A companion product, MFTC: Mutual Fund Tax Calculator for Windows 3.1 (or greater)
is available from RCCO Research in a 16-bit edition. It is similar to, but not exactly like,
the present work entitled MFTC32: Mutual Fund Tax Calculator, 32-bit edition. The two
editions have different registration fees, due to the program sizes and number of disks
involved for each. The respective version numbers may also differ and should not be
considered relative to the other edition. Please specify the appropriate title desired on
your order.

(C) Copyright 1995-96 RCCO Research Associates
All Rights Reserved under International Conventions
Product of U.S.A.

RCCO Research is also the publisher of MONEY & BANKS, Personal Banking Manager
software (a leading personal financial program for DOS systems) and Portfolio Pages32,
Personal Investments Management for 32-bit Windows.

Also available from your favorite user-supported software source:

Portfolio Pages32

Personal Investments Management

for 32-bit Windows



RCCO Research's PORTFOLIO PAGES32 is a visually-oriented approach to maintaining
summaries and details for personal investments records. Based on a concept of tabbed
file pages representing a multiple-table system of an investment portfolio, the program
allows for a broad range of recordkeeping for mutual funds, stocks, bonds, cash
accounts, real estate and other assets, as well as including provision for various
retirement accounts. After detail particulars are entered by the user, various summary
pages and a printed report offer perspective and an overall portrait of aggregate assets.

Portfolio Pages32 is meant to provide a simple, non-technical method for investors to
perceive their investments, savings, and retirement accounts in various stages of
creation and as ones which are easily maintainable over periods of time. Each page of
differing types of accounts may be viewed/edited in a table view grid approach to
maintaining data. Automatically calculating summary pages reflect various portions of
the portfolio and provide instantaneous display panel updates based upon share price
changes, additions, deletions, or other edits. An easy-to-use single-button selection for
the report writer prints a formatted tabular report for all securities, accounts, and other
holdings.

Complete documentation and help is available online, as well as in Windows .DOC
format (suitable for printing).

Program specifications: Portfolio Pages32 requires an 80386sx or greater processor and
32-bit Windows operating system.

RCCO Research Associates
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